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Reviewed by: Jay McGowan

This tutorial provides step-by-step instructions for efficiently processing large numbers of files
following eBird/Macaulay Library’s audio preparation and upload guidelines.

We break down the process of editing audio files with Audacity for upload to eBird into five
sections:

1. File Management
2. Set Up
3. Viewing Audio
4. Editing Audio
5. Tips and Tricks for eBird Manage Media

Turdus leucomelas (Pale-breasted Thrush)
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1. File Management
All digital recorders name files with sequential, unique identification numbers plus time/date
information in the file’s metadata. Some devices will automatically place all files from a given
day in their own folder (e.g. Sound Devices MixPre3) or name files with time/date information
(e.g. 20230210110019.WAV is 11:00:19 February 10, 2023). Ideally, all files for a given date are
stored in their own folder labeled by date.

It is also possible to rename files so they are more informative. File names can be modified in
large batches using custom code or online tools (search Google for “batch rename files”). For
example, “2023.02.10_11.00.19.WAV” is easier to understand than “20230210110019.WAV”.

It is always a good idea to back up audio files before beginning to edit them. However, with
Audacity this is not strictly necessary because Audacity does not destructively edit audio files
(as in Ocenaudio). That is, there is no ‘Save As’ option that will automatically overwrite your
audio file. The only way to overwrite an audio file is to File > Export > Export Audio…, name
your exported file the same name as one of your original files, and then confirm you want to
overwrite the file. But don’t do this!

Spizella atrogularis (Black-chinned Sparrow)
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2. Set Up
In order to get the most of Audacity, let’s first make a few adjustments to the default settings
before we start editing.

Mac vs. Windows - For simplicity only Mac shortcuts and menu paths are used in this document.
Audacity for Windows is very similar to Mac with two key differences;

Preferences - In Windows, Preferences can be found in the Edit menu (Windows: Edit >
Preferences > etc)

Shortcuts - shortcuts for Mac and Windows are the same, just use Ctrl for Windows
and⌘ (Cmd) for Mac.

1. Download and install Audacity
https://www.audacityteam.org/download/mac/
https://www.audacityteam.org/download/windows/

2. Open Audacity

3. Adjust a few settings.
● Audacity > Preferences > Tracks > Default view mode: Spectrogram*
● Audacity > Preferences > Tracks - Spectrograms >

○ Scale “Linear”
○ Min Frequency (Hz): 0
○ Max Frequency (Hz): 10000 (most birds don’t sing much above 10kHz)
○ Algorithm: Frequencies
○ Window Size: 1024 - default
○ Window Type: Hann
○ Zero padding factor: 2
○ unselect Enable Spectral Selection

*You can also select Default view mode: Multiview to view an audio file’s waveform and spectrogram at
the same time. The waveform view is useful to quickly assess overall quality (single-to-noise ratio) and if
parts of a recording are clipped (i.e. 0 dB). Multiview takes up more screen space, so experiment to
decide what you prefer.

4. Add a few important keyboard shortcuts that are not pre-set.
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To add a shortcut first go to Preferences > Keyboard then search for the function’s
name in the search field. Click on the function and type the key sequence into the field at
the bottom and click Set.

● Silence: S
● Normalize: N
● Amplify: A
● Mono Track (Add New): M
● Export Audio as WAV: E

Zonotrichia capensis (Rufous-collared Sparrow)
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3. Viewing Audio
Once Audacity is installed, preferences set, and shortcuts enabled, we’re ready to view and
explore our audio files. Throughout this tutorial we’ll be working with three audio files from a
single recording event; a Sporophila nigricollis (Yellow-bellied Seedeater) from Caldas,
Colombia (ML535078381). The first file was recorded from 15 meters, the second file was
recorded from 5 meters after approaching the bird, the third file is a voice announcement
describing the recording event.

You can follow the same steps below with your own set of recordings if you’d like. Select a set of
two or more recordings from the same recording event to start.

1. Audio Import: Drag and drop your files into the Audacity workspace (Fig 1). (Tip: look at
the file time stamps to make sure all files from a single recording event are imported
together)

Figure 1. Spectrogram multitrack view showing three unedited audio files. Note the Track
Control panel at the start (left side) of each track. Clicking on the blank space in the settings

panel at the left or in the grey bar at the top of the track will select the entire track.

2. Track Playback: A track must be “Solo-ed” to be played independently of the other
tracks. To solo a track, click on the track then press Shift + S. The track is now soloed
(Figure 2).

Press Space to play from the cursor position. To play the track from the start, press J
(moves cursor to the start of the track) then the Space bar.
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Repeat these steps to listen to the other tracks.

Figure 2. Track 1 is soloed and the other two tracks are muted.

3. Track Navigation: While pressing⌘, use the mouse’s scroll function to zoom in or out of
the track. Alternatively, highlight a section of the track by clicking and dragging to select
the section of interest. Press⌘ + E to zoom in on that selection.

To zoom back out to view the full track, select the entire track (Shift + J + K or
double-click the spectrogram), then press⌘ + E.

Selasphorus heloisa (Bumblebee Hummingbird)
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4. Editing Audio
Introduction
Example Workflow 1
Example Workflow 2
Audacity Tips
Review of Important Keyboard Shortcuts

Introduction
Now that we know how to navigate and explore our audio files we will now learn a precise
sequence of steps to efficiently trim, normalize, combine, and export audio files.

1. Trim - remove sections of audio from the beginning and/or end that we don’t want in the
archived file

2. Normalize - amplify audio to bring peak amplitude to a standardized level
3. Combine - combine audio files from the same recording event in chronological order
4. Export - export trimmed, normalized, and combined audio files as a single WAV file for

eBird upload

We will use keyboard shortcuts whenever possible. Keyboard shortcuts are crucial to efficiently
edit large numbers of audio files in any audio editing program. At the end of Section 4 is a full
list of the keyboard shortcuts used in this tutorial.

Example Workflow 1: Trim, Normalize, Combine, and Export multiple files

1. Trim: At the start of Track 1 there is some handling noise and then the gain was turned
down after the first song bout. At the end, a Pionus menstruus (Blue-headed Parrot) flies
by calling loudly, obscuring the final two song bouts. We will trim both these sections of
the file.

To trim the start,
- zoom in
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- put the cursor at ~0:06
- select from the cursor to the start (Shift + J)
- press Delete

To trim the end
- zoom out to the full track (Shift + J + K then⌘ + E)
- zoom in to the end
- put the cursor at ~1:37 (where the parrot starts calling loudly)
- select from the cursor to end (Shift + K)
- press Delete

Zoom out to the full track to view the result (Shift + J + K then⌘ + E).

Repeat Step 5 for the remaining two tracks to trim unwanted sections of audio from the
beginning or end. Do not remove sections of audio between the beginning and end as
this will alter the time between call bouts (important information for scientists). If
possible, remember to leave about 3 seconds of the audio file before the start of the first
focal sound and after the end of the last focal sound.

2. Normalize: In this step we will amplify the audio to bring the peak amplitude to a
standardized level of -3dB for bird sound and -10dB for voice announcements (Figure 3).
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Figure 3. The same song bout of Sporophila nigricollis prior to normalization (top) and
after normalization to -3dB (bottom). These tracks are displayed in Multi-view (Audacity
> Preferences > Tracks > Multi-view) to show both the waveform and the spectrogram.
We recommend processing tracks using only spectrograms so you can see more tracks
at once.

To normalize…
- Select the entire track (Shift + J + K or double-click the spectrogram)
- press N
- In the normalization dialog box that appears, enter -3.0 dB in Normalize

peak amplitude to
- Leave Remove DC offset selected
- Leave Normalize stereo channels independently deselected
- Press Enter (click Apply)

The track is now normalized to have a peak amplitude of -3.0 dB.

Repeat for the other tracks. Remember, the voice announcement is normalized to -10
dB.

Note that a section of audio only has to be selected to normalize, not necessarily soloed.
To quickly normalize a set of tracks that have already been trimmed, select each track
one-by-one (double-click the spectrogram) and normalize (N).

Remember, we want to normalize each track to its own loudest sound. Do not select
multiple tracks at once and normalize. This normalizes to the loudest sound in all the
tracks.

3. Combine: We now want to combine these three trimmed and normalized tracks into a
single track for export with each track separated by 1 sec of digital silence.

Starting with the last track,
- select the entire track with the mouse (double-click on the spectrogram)
- copy the selection (⌘ + C)
- select the next track up (i.e. the previous track)
- move the cursor to the end (K)
- add silence (S)
- adjust to 1 sec
- press Enter.
- move cursor to end of the silence (K)
- paste the last track at the end (⌘ + V)
- zoom out to entire track (Shift + J + K then⌘ + E) to view the result.
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Repeat these steps to add the combined Tracks 2+3 to Track 1. Press Shift + J + K then
⌘ + E to view the resulting combined Tracks 1 + 2 + 3.

4. Export: We’re now ready to export the combined track to a wav file for upload to eBird.
When working with large sets of recordings for upload to numerous eBird checklists, an
informative and consistent file naming system is important to quickly locate the file you
want to upload to a particular checklist.

Ideally, names should include date, unique track identifier(s), taxonomic identification,
and a star rating from 1-5. Adding the star rating when you’ve just edited the file(s) is
more efficient than determining the rating while uploading to the checklist. For this track,
we’ll use the file name - 2022.07.19_07.01-07.07_Sporophila.nigricollis_5.wav

Date - 2022.07.19
Unique File Identifiers - This identifier should reference the original parent file (or
files) that the exported track was created from. Depending on your recorder, these
may be consecutive integers or timestamps. In our Sporophila example, 07.01,
07.06, and 07.07 are timestamps which uniquely identify the three files. 07.01-07.07
indicates all files including and between 07.01 and 07.07.
Genus.Species - Sporophila.nigricollis
Rating - 5 (rating 1 out of 5 based on the best section of the track, see our Rating
Media guide for more information)

To export…
- Solo the combined Tracks 1 + 2 + 3 and press E. CAUTION: Make sure only one

track is soloed prior to exporting. If multiple tracks are soloed, all soloed tracks
will get mixed into the exported file. If no tracks are soloed, all tracks will get
mixed into the exported file.

- Name the file with its date, track identifier(s), taxonomic identification, and a star
rating.

- Navigate to the directory you want to save the file in. We recommend you save it
to the same directory that the raw audio files for that particular day are saved.

- Ensure that the Encoding is set to the same encoding used to make the
recording. If you recorded in 24-bit, use “Signed 24-bit”, etc. Audacity will
remember your selection for future exports.

- Press Save.
- Audacity will prompt you to Edit Metadata Tags. This is not necessary. First select

“Don’t show this when exporting audio”, then click OK. This box will not appear
again next time you export.

5. Clean up: Close files you have already processed to keep your Audacity workspace
organized.
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Congratulations! You’ve processed your first recording event. Your trimmed, normalized, and
combined file is now in the directory you selected ready for eBird upload!

Take the time to practice trimming, normalizing, combining, and exporting using the steps and
keyboard shortcuts above. This process will quickly become second nature as your fingers learn
the keyboard shortcuts allowing you to efficiently process many files. With practice, the set of
three audio files we just worked on should only take about 1-2 minutes to process.

Example Workflow 2: Making new tracks from background sounds

In Example Workflow 1, we removed a noisy Pionus menstruus (Blue-headed Parrot) from the
end of the first track (2022.07.19_07.01.WAV) in Step 4. There are very few recordings of the
species from the central Cauca Valley in Colombia, so let’s upload this section of audio to eBird
for documentation using the following steps…

1. Extract: Instead of selecting the section with the noisy parrot and deleting (as we did in
Step 4), we’re going to extract the parrot vocalizations.

- Place the cursor at 1:39 in track 2022.07.19_07.01.WAV
- press Shift + K (selects from cursor to end)
- extract this section of audio with⌘ +C
- it is now stored in your clipboard.

2. Create New Mono Track and Paste:
- Create a new mono track (M)
- move the cursor to the start (J)
- paste the copied section of audio (⌘ + V)

3. Trim: We’ll trim out the first Sporophila song bout.
- Place the cursor at 0:06
- press Shift + J
- press Delete.

4. Normalize:
- Select the entire track (Shift + J + K)
- normalize (N)
- set to -3 dB
- Enter
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5. Export:
- solo the track (Shift + S)
- export as WAV (E)
- name and rate file as recommended in Step 4 of Example Workflow 1.

Audacity Tips
1. If your recordings appear as two-channel mono tracks you’ll want to only process

one-channel. Click “Split stereo to mono” using the drop down menu in the settings panel
opened by Shift + M.

2. Import 20-30 files at a time using drag-drop. Importing large numbers of files may cause
Audacity to crash.

3. If Audacity gives you the following error “Error: Error opening sound device” when you try
to press Play, go to the Menu bar and click Transport > Rescan Audio Devices. Make
sure the audio

4. To export a single track, the track must be ‘Solo’. If multiple tracks are Solo all Solo
tracks will get mixed into the exported file. If none are Solo, all tracks will get mixed into
the exported file.

Review of Important Keyboard Shortcuts
Shortcuts below are for Mac. For Windows, replace the⌘ (Cmd) with Ctrl.
Use Preferences > Keyboard to search and set shortcuts.

Navigation
Solo/Unsolo a Focused Track: Shift + S (must solo a track to edit and export)
Cursor to - Track Start: J
Cursor to - Track End: K
Select to Track End from Cursor: Shift + K
Select to Track Start from Cursor: Shift + J
Zoom to Selection:⌘ + E
Temporal Zoom In/Out of Track:⌘ + page scroll up/down (two fingers on Mac
touchpad)
Temporal Scrolling: page scroll up/down (two fingers on Mac touchpad)
Select a Portion of Track: Mouse - click and drag

Playback
Play/Pause (resets to cursor): Space
Play/Pause (starts again at cursor): X

Editing
Delete Selection: Delete
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Copy Selection:⌘ + C
Cut Selection:⌘ + X
Paste Selection:⌘ + V
Add Silence At Cursor: Shift +⌘ + S (adjust to 1 sec)
Open Menu on Focused Track: Shift + M (necessary to split stereo to mono)
Normalize: N
Amplify: A (alternative to Normalize but also shows peak amplitude of selection)
Add New Mono Track: M (for making new tracks from segments of other tracks)
Export Audio as WAV: E (to export a single track the track must be soloed)

Useful shortcut combos
Select entire track: 1) Shift + J + K, or 2) J then Shift + K, or 3) K then Shift + J

Vireo chivi (Chivi Vireo)
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5. Tips and Tricks for eBird Manage Media
It is most efficient to first process a set of recordings, then upload them to eBird. We
recommend processing, uploading, adding meta-data, and editing checklists in single day
batches. When you’ve finished processing a day’s recordings, move on to the next day. That
said, you might not have the mental energy to add notes and research unknowns. If so, we
often continue editing recordings so they'll be ready for upload and scrutiny when we get to their
checklist.

1. Upload Recordings via Manage Media: Click on the Manage Media tool for a checklist
and organize your application windows such that you can see both Manage Media and
the directory with your files (Figure 3).

Figure 3. Manage Media and your file directory are both visible allowing one to quickly
drag and drop files into their species’.

Drag and drop the files to their species. Use the Search Species tool at the top to quickly
filter the list to find the next species.

2. Edit Species List while in Manage Media: It is not possible to directly edit the species list
while in Manage Media. A workaround is to open the normal checklist view in a new tab
and Edit Species.
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- From the Manage Media right-click on the Done button and select Open Link in
New Tab. This will open a new tab with the checklist.

- Enter the Edit Species tool, add/change your desired species, click Save.
- Refresh the Manage Media tab and the edits to the species list will appear.

3. Adding Background Species: Adding background species provides documentation for
the species for which you did not obtain a decent focal recording. It is also incredibly
valuable to researchers who study soundscapes.

After an audio file file is uploaded and the spectrogram viewable (click refresh if the
audio file says Processing Audio) click on the Spectrogram and it will expand. Listen
carefully to the background species and add species using the Additional Species field.

Note: only species that are already on the checklist can be selected. If you hear a
species that is not on the checklist, follow the instructions above for Edit Species List
while in Manage Media.

4. Identification Method - It’s great to include some basic information about how the
vocalization was identified. Put yourself in the place of an eBird reviewer who doesn’t
know how amazing your field identification skills are. What information would that
reviewer want to see to trust your identification?

At the minimum, we try to include either “ID by sight” or “ID by sound”, particularly for
challenging sound ID problems. If you can include more information about how you
arrived at the ID, please do so.

- ID by sight.
- ID by sound.
- ID by sight and sound.
- ID by sound by our guide, Otto.
- ID by sound, not confirmed by sight.
- Identical to Merlin reference recordings of song
- Very similar to MLXXXXXXXX and MLXXXXXXX. Distinguished from Confusion

Species by these characteristics.

5. Unknowns: For recordings with unknown IDs, please upload as Aves sp. or a specific
taxonomic group if known. It's easier to share recordings of unknowns for identification
with an ML link associated with a checklist than as a file. To change the identification,
use the Edit Species tool, navigate to the species, and click Change Species.
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6. Recordings But No Checklist? - No problem. Make an Incidental Checklist for the time,
date, and locality the recording(s) were made, add the focal species to the checklist
using Edit Species, save, then enter Manage Media and upload the recordings as
normal.

Sayornis phoebe (Eastern Phoebe)
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Ocenaudio vs. Audacity
Ocenaudio and Audacity are both free programs that are great options for editing audio
recordings. The main difference between the two programs is that Ocenaudio presents the
spectrogram/waveform of one audio file at a time whereas Audacity can display the
spectrograms of many audio files in its multitrack view. Ocenaudio also supports more file
formats. For instance, the compressed file format m4a/mp4 commonly used by smartphones to
store audio can be opened by Ocenaudio but not Audacity.

The single track view of Ocenaudio is simpler, focusing on one audio track at a time. This
simplicity may be helpful to someone editing their first audio recordings. In contrast, Audacity’s
multitrack view allows the user to scan through the spectrograms of large batches of files to
assess which files they want to trim/normalize/combine, or not. This is advantageous for
recordists who have large numbers of files to process. Audacity’s multitrack format and
shortcuts takes a bit more time to learn how to use effectively but results in a fast audio
processing pipeline.

17


